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Get	Free	WPS	Office	suite	to	create	best	Word	documents,	Excel	spreadsheets,	PPT	slides,	and	PDF	on	Windows,	PC,	Mac,	Linux,	Android,	and	iOS	devices.	Download	professional	WPS	Office	for	students,	teachers,	business	users,	and	finance	industry	users,	making	it	easy	to	work	anywhere,	anytime,	with	anyone.	WPS	Office	provides	over	100,000
free	templates	that	are	easy	to	edit	and	customize.	Download	the	best	free	WPS	Office	suite	to	promote	your	business.	For	more	information,	visit:	Proprietary	software	whose	full	use	is	limited	in	timeShareware	is	a	type	of	proprietary	software	that	is	initially	shared	by	the	owner	for	trial	use	at	little	or	no	cost.[1]	Often	the	software	has	limited
functionality	or	incomplete	documentation	until	the	user	sends	payment	to	the	software	developer.[2]	Shareware	is	often	offered	as	a	download	from	a	website.	Shareware	differs	from	freeware,	which	is	fully-featured	software	distributed	at	no	cost	to	the	user	but	without	source	code	being	made	available;	and	free	and	open-source	software,	in	which
the	source	code	is	freely	available	for	anyone	to	inspect	and	alter.There	are	many	types	of	shareware	and,	while	they	may	not	require	an	initial	up-front	payment,	many	are	intended	to	generate	revenue	in	one	way	or	another.	Some	limit	use	to	personal	non-commercial	purposes	only,	with	purchase	of	a	license	required	for	use	in	a	business	enterprise.
The	software	itself	may	be	time-limited,	or	it	may	remind	the	user	that	payment	would	be	appreciated.Trialware	or	demoware	is	a	program	that	limits	the	time	that	it	can	be	effectively	used,	commonly	via	a	built-in	time	limit,	number	of	uses,	or	only	allowing	progression	up	to	a	certain	point	(e.g.	in	video	games,	see	Game	demo).[3]	The	user	can	try
out	the	fully	featured	program	until	the	trial	period	is	up,	and	then	most	trialware	reverts	to	either	a	reduced-functionality	(freemium,	nagware,	or	crippleware)	or	non-functional	mode,	unless	the	user	purchases	a	full	version.[4]	Trialware	has	become	normalized	for	online	Software	as	a	Service	(SaaS).[citation	needed]	WinRAR	is	a	notable	example	of
an	unlimited	trialware,	i.e.	a	program	that	retains	its	full	functionality	even	after	the	trial	period	has	ended.The	rationale	behind	trialware	is	to	give	potential	users	the	opportunity	to	try	out	the	program	to	judge	its	usefulness	before	purchasing	a	license.	According	to	industry	research	firm	Softletter,	66%	of	online	companies	surveyed	had	free-trial-
to-paying-customer	conversion	rates	of	25%	or	less.	SaaS	providers	employ	a	wide	range	of	strategies	to	nurture	leads,	and	convert	them	into	paying	customers.Main	article:	FreemiumFreemium	works	by	offering	a	product	or	service	free	of	charge	(typically	digital	offerings	such	as	software,	content,	games,	web	services	or	other)	while	charging	a
premium	for	advanced	features,	functionality,	or	related	products	and	services.	For	example,	a	fully	functional	feature-limited	version	may	be	given	away	for	free,	with	advanced	features	disabled	until	a	license	fee	is	paid.	The	word	freemium	combines	the	two	aspects	of	the	business	model:	"free"	and	"premium".[5]	It	has	become	a	popular	model
especially	in	the	antivirus	industry.Main	article:	AdwareAdware,	short	for	"advertising-supported	software",	is	any	software	package	which	automatically	renders	advertisements	in	order	to	generate	revenue	for	its	author.	Shareware	is	often	packaged	with	adware	to	lower	the	shareware	fees	or	eliminate	the	need	to	charge	users	a	fee.	The
advertisements	may	take	the	form	of	a	banner	on	an	application	window.	The	functions	may	be	designed	to	analyze	which	websites	the	user	visits	and	to	present	advertising	pertinent	to	the	types	of	goods	or	services	featured	there.	The	term	is	sometimes	used	to	refer	to	software	that	displays	unwanted	advertisements,	which	typically	are	more
intrusive	and	may	appear	as	pop-ups,	as	is	the	case	in	most	ad-oriented	spyware.[6]	During	the	installation	of	the	intended	software,	the	user	is	presented	with	a	requirement	to	agree	to	the	terms	of	click	through	an	end-user	license	agreement	or	similar	licensing	which	governs	the	installation	of	the	software.[7]Main	article:	CripplewareCrippleware
has	vital	features	of	the	program,	such	as	printing	or	the	ability	to	save	files,	disabled	or	unwanted	features	like	watermarks	on	screencasting	and	video	editing	software[8]	until	the	user	buys	the	software.	This	allows	users	to	take	a	close	look	at	the	features	of	a	program	without	being	able	to	use	it	to	generate	output.	The	distinction	between
freemium	and	crippleware	is	that	an	unlicensed	freemium	program	has	useful	functionality,	while	crippleware	demonstrates	its	potential	but	is	not	useful	on	its	own.Main	article:	DonationwareDonationware	is	a	licensing	model	that	supplies	fully	operational	unrestricted	software	to	the	user	and	requests	an	optional	donation	be	paid	to	the
programmer	or	a	third-party	beneficiary	(usually	a	non-profit).[9]	The	amount	of	the	donation	may	also	be	stipulated	by	the	author,	or	it	may	be	left	to	the	discretion	of	the	user,	based	on	individual	perceptions	of	the	software's	value.	Since	donationware	comes	fully	operational	(i.e.	not	crippleware)	with	payment	optional,	it	is	a	type	of	freeware.	In
some	cases,	there	is	a	delay	to	start	the	program	or	"nag	screen"	reminding	the	user	that	they	haven't	donated	to	the	project.	This	nag	feature	and/or	delayed	start	is	often	removed	in	an	update	once	the	user	has	donated	to	(paid	for)	the	software.Nagware	(also	known	as	begware,	annoyware	or	a	nagscreen)	is	a	pejorative	term	for	shareware	that
persistently	reminds	the	user	to	purchase	a	license.[10]	It	usually	does	this	by	popping	up	a	message	when	the	user	starts	the	program,	or	intermittently	while	the	user	is	using	the	application.	These	messages	can	appear	as	windows	obscuring	part	of	the	screen,	or	as	modal	window	message	boxes	that	can	quickly	be	closed.	Some	nagware	keeps	the
message	up	for	a	certain	time	period	and	locking	the	application,	forcing	the	user	to	wait	to	continue	to	use	the	program.	Unlicensed	programs	that	support	printing	may	superimpose	a	watermark	on	the	printed	output,	typically	stating	that	the	output	was	produced	by	an	unlicensed	copy.Some	titles	display	a	dialog	box	with	payment	information	and
a	message	that	paying	will	remove	the	notice,	which	is	usually	displayed	either	upon	startup	or	after	an	interval	while	the	application	is	running.	These	notices	are	designed	to	annoy	the	user	into	paying.Postcardware,	also	called	just	cardware,	is	a	style	of	software	distribution	similar	to	shareware,	distributed	by	the	author	on	the	condition	that	users
send	the	author	a	postcard.	A	variation	of	cardware,	emailware,	uses	the	same	approach	but	requires	the	user	to	send	the	author	an	email.	Postcardware,	like	other	novelty	software	distribution	terms,	is	often	not	strictly	enforced.	Cardware	is	similar	to	beerware.The	concept	was	first	used	by	Aaron	Giles,	author	of	JPEGView.[11]	Another	well-known
piece	of	postcardware	is	the	roguelike	game	Ancient	Domains	of	Mystery,	whose	author	collects	postcards	from	around	the	world.	Orbitron	is	distributed	as	postcardware.	Exifer	is	a	popular	application	among	digital	photographers	that	has	been	postcardware.[12]	Caledos	Automatic	Wallpaper	Changer	is	a	"still	alive"	project	cardware.	"Empathy"	is
a	postcardware	for	password-protected	executables.	Dual	Module	Player	and	Linux	were	also	postcardware	for	a	long	time.[13]	An	example	for	emailware	is	the	video	game	Jump	'n	Bump.[14]	Another	popular	postcardware	company	is	the	Laravel	package	developers	from	Spatie,	which	has	released	over	200	open-source	packages	to	the	Laravel
framework,	which	are	postcardware	licensed,	and	all	shown	at	their	website.[15]In	1982,	Andrew	Fluegelman	created	a	program	for	the	IBM	PC	called	PC-Talk,	a	telecommunications	program,	and	used	the	term	freeware;	he	described	it	"as	an	experiment	in	economics	more	than	altruism".[16]	About	the	same	time,	Jim	"Button"	Knopf	released	PC-
File,	a	database	program,	calling	it	user-supported	software.[17]	Not	much	later,	Bob	Wallace	produced	PC-Write,	a	word	processor,	and	called	it	shareware.	Appearing	in	an	episode	of	Horizon	titled	Psychedelic	Science	originally	broadcast	5	April	1998,	Bob	Wallace	said	the	idea	for	shareware	came	to	him	"to	some	extent	as	a	result	of	my
psychedelic	experience".[18]Fluegelman	said	that	his	experience	as	a	book	publisher	and	author	discouraged	him	from	finding	a	traditional	software	publisher.	KQED	pledge	drives	inspired	his	distribution	method,	as	well	as	his	not	knowing	how	to	implement	copy	protection.[19]In	1983	Jerry	Pournelle	wrote	of	"an	increasingly	popular	variant"	of
free	software	"that	has	no	name,	but	works	thus:	'If	you	like	this,	send	me	(the	author)	some	money.	I	prefer	cash.'"[20]	In	1984,	Softalk-PC	magazine	had	a	column,	The	Public	Library,	about	such	software.	Public	domain	is	a	misnomer	for	shareware,	and	Freeware	was	trademarked	by	Fluegelman	and	could	not	be	used	legally	by	others,	and	User-
Supported	Software	was	too	cumbersome.	So	columnist	Nelson	Ford	had	a	contest	to	come	up	with	a	better	name.The	most	popular	name	submitted	was	Shareware,	which	was	being	used	by	Wallace.	However,	Wallace	acknowledged	that	he	got	the	term	from	an	InfoWorld	magazine	column	by	that	name	in	the	1970s[failed	verification][citation
needed],	and	that	he	considered	the	name	to	be	generic,[21]	so	its	use	became	established	over	freeware	and	user-supported	software.[22]By	1984	Knopf	reported	receiving	about	$1,000	a	day	for	PC-File,[23]	and	by	1985	Fluegelman	was	receiving	"dozens	of	$35	checks"	daily.	He	had	two	employees	to	fulfill	orders	and	answer	questions	for	PC-Talk.
[19]	He,	Knopf,	and	Wallace	clearly	established	shareware	as	a	viable	software	distribution	model	by	becoming	wealthy.[24][25]Prior	to	the	popularity	of	the	World	Wide	Web	and	widespread	Internet	access,	shareware	was	often	the	only	economical	way	for	independent	software	authors	to	get	their	product	onto	users'	desktops.	Those	with	Internet
or	BBS	access	could	download	software	and	distribute	it	amongst	their	friends	or	user	groups,	who	would	then	be	encouraged	to	send	the	registration	fee	to	the	author,	usually	via	postal	mail.	During	the	late	1980s	and	early	1990s,	shareware	software	was	widely	distributed	over	online	services,	bulletin	board	systems	and	on	diskettes.	Contrary	to
commercial	developers	who	spent	millions	of	dollars	urging	users	"Don't	Copy	That	Floppy",	shareware	developers	encouraged	users	to	upload	the	software	and	share	it	on	disks.Commercial	shareware	distributors	such	as	Educorp	and	Public	Domain	Inc	printed	catalogs	describing	thousands	of	public	domain	and	shareware	programs	that	were
available	for	a	small	charge	on	floppy	disk.	These	companies	later	made	their	entire	catalog	available	on	CD-ROM.	One	such	distributor,	Public	Software	Library	(PSL),	began	an	order-taking	service	for	programmers	who	otherwise	had	no	means	of	accepting	credit	card	orders.	Meanwhile	major	online	service	provider	CompuServe	enabled	people	to
pay	(register)	for	software	using	their	CompuServe	accounts.	When	AOL	bought	out	CompuServe,	that	part	of	CompuServe	called	SWREG	(Shareware	Registration)	was	sold	to	UK	businessman	Stephen	Lee	of	Atlantic	Coast	PLC	who	placed	the	service	on	to	the	internet	and	enabled	over	3,000	independent	software	developers	to	use	SWREG	as	a
back	office	to	accept	various	payment	methods	including	credit,	debit	and	charge	cards,	Paypal	and	other	services	in	multiple	currencies.	This	worked	in	realtime	so	that	a	client	could	pay	for	software	and	instantly	download	it	which	was	novel	at	the	time.	SWREG	was	eventually	bought	by	Digital	River,	Inc.	Also,	services	like	Kagi	started	offering
applications	that	authors	could	distribute	along	with	their	products	that	would	present	the	user	with	an	onscreen	form	to	fill	out,	print,	and	mail	along	with	their	payment.	Once	telecommunications	became	more	widespread,	this	service	also	expanded	online.	Toward	the	beginning	of	the	Internet	era,	books	compiling	reviews	of	available	shareware
were	published,	sometimes	targeting	specific	niches	such	as	small	business.	These	books	would	typically	come	with	one	or	more	floppy	disks	or	CD-ROMs	containing	software	from	the	book.[26]As	Internet	use	grew,	users	turned	to	downloading	shareware	programs	from	FTP	or	web	sites.	This	spelled	the	end	of	bulletin	board	systems	and	shareware
disk	distributors.	At	first,	disk	space	on	a	server	was	hard	to	come	by,	so	networks	like	Info-Mac	were	developed,	consisting	of	non-profit	mirror	sites	hosting	large	shareware	libraries	accessible	via	the	web	or	ftp.	With	the	advent	of	the	commercial	web	hosting	industry,	the	authors	of	shareware	programs	started	their	own	sites	where	the	public
could	learn	about	their	programs	and	download	the	latest	versions,	and	even	pay	for	the	software	online.	This	erased	one	of	the	chief	distinctions	of	shareware,	as	it	was	now	most	often	downloaded	from	a	central	"official"	location	instead	of	being	shared	samizdat-style	by	its	users.	To	ensure	users	would	get	the	latest	bug-fixes	as	well	as	an	install
untainted	by	viruses	or	other	malware,	some	authors	discouraged	users	from	giving	the	software	to	their	friends,	encouraging	them	to	send	a	link	instead.Major	download	sites	such	as	VersionTracker	and	CNet's	Download.com	began	to	rank	titles	based	on	quality,	feedback,	and	downloads.	Popular	software	was	sorted	to	the	top	of	the	list,	along	with
products	whose	authors	paid	for	preferred	placement.If	features	are	disabled	in	the	freely	accessible	version,	paying	may	provide	the	user	with	a	license	key	or	code	they	can	enter	into	the	software	to	disable	the	notices	and	enable	full	functionality.	Some	pirate	web	sites	publish	license	codes	for	popular	shareware,	leading	to	a	kind	of	arms	race
between	the	developer	and	the	pirates	where	the	developer	disables	pirated	codes	and	the	pirates	attempt	to	find	or	generate	new	ones.	Some	software	publishers	have	started	accepting	known	pirated	codes,	using	the	opportunity	to	educate	users	on	the	economics	of	the	shareware	model.[27]Some	shareware	relies	entirely	on	the	user's	honesty	and
requires	no	password.	Simply	checking	an	"I	have	paid"	checkbox	in	the	application	is	all	that	is	required	to	disable	the	registration	notices.[28][29]Main	article:	Game	demoThis	article	needs	additional	citations	for	verification.	Please	help	improve	this	article	by	adding	citations	to	reliable	sources.	Unsourced	material	may	be	challenged	and
removed.Find	sources:"Shareware"news	newspapers	books	scholar	JSTOR	(December	2016)	(Learn	how	and	when	to	remove	this	message)In	the	early	1990s,	shareware	distribution	was	a	popular	method	of	publishing	games	for	smaller	developers,	including	then-fledgling	companies	Apogee	Software	(also	known	as	3D	Realms),	Epic	MegaGames
(now	Epic	Games),	Ambrosia	Software	and	id	Software.	It	gave	consumers	the	chance	to	play	the	game	before	investing	money	in	it,	and	it	gave	them	exposure	that	some	products	would	be	unable	to	get	in	the	retail	space.With	the	Kroz	series,	Apogee	introduced	the	"episodic"	shareware	model	that	became	the	most	popular	incentive	for	buying	a
game.[30]	While	the	shareware	game	would	be	a	truly	complete	game,	there	would	be	additional	"episodes"	of	the	game	that	were	not	shareware	and	could	only	be	legally	obtained	by	paying	for	the	shareware	episode.	In	some	cases	these	episodes	were	neatly	integrated	and	would	feel	like	a	longer	version	of	the	game,	and	in	other	cases	the	later
episodes	would	be	stand-alone	games.	Sometimes	the	additional	content	was	completely	integrated	with	the	unregistered	game,	such	as	in	Ambrosia's	Escape	Velocity	series,	in	which	a	character	representing	the	developer's	pet	parrot,	equipped	with	an	undefeatable	ship,	would	periodically	harass	and	destroy	the	player	after	they	reached	a	certain
level	representing	the	end	of	the	trial	period.Racks	of	games	on	single	51/4-inch	and	later	3.5-inch	floppy	disks	were	common	in	retail	stores.	However,	computer	shows[citation	needed]	and	bulletin	board	systems	(BBS)	such	as	Software	Creations	BBS	were	the	primary	distributors	of	low-cost	software.	Free	software	from	a	BBS	was	the	motivating
force	for	consumers	to	purchase	a	computer	equipped	with	a	modem,	so	as	to	acquire	software	at	no	cost.	The	success	of	shareware	games,	including	id	Software	hits	Commander	Keen	and	Doom,	depended	in	part	on	the	BBS	community's	willingness	to	redistribute	them	from	one	BBS	to	another	across	North	America.	The	reasons	for	redistribution
included	allowing	modem	users	who	could	not	afford	long-distance	calls	the	opportunity	to	view	the	games.[31]The	important	distinguishing	feature	between	a	shareware	game	and	a	game	demo	is	that	the	shareware	game	is	(at	least	in	theory)	a	complete	working	software	program	albeit	with	reduced	content	compared	to	the	full	game,	while	a	game
demo	omits	significant	functionality	as	well	as	content.	Shareware	games	commonly	offered	both	single	player	and	multiplayer	modes	plus	a	significant	fraction	of	the	full	game	content	such	as	the	first	of	three	episodes,	while	some	even	offered	the	entire	product	as	shareware	while	unlocking	additional	content	for	registered	users.	By	contrast	a
game	demo	may	offer	as	little	as	one	single-player	level	or	consist	solely	of	a	multiplayer	map,	this	makes	them	easier	to	prepare	than	a	shareware	game.There	are	several	widely	accepted	standards	and	technologies	that	are	used	in	the	development	and	promotion	of	shareware.FILE_ID.DIZ	is	a	descriptive	text	file	often	included	in	downloadable
shareware	distribution	packages.Portable	Application	Description	(PAD)	is	used	to	standardize	shareware	application	descriptions.	PAD	file	is	an	XML	document	that	describes	a	shareware	or	freeware	product	according	to	the	PAD	specification.[32]DynamicPAD	extends	the	Portable	Application	Description	(PAD)	standard	by	allowing	shareware
vendors	to	provide	customized	PAD	XML	files	to	each	download	site	or	any	other	PAD-enabled	resource.	DynamicPAD	is	a	set	of	server-side	PHP	scripts	distributed	under	a	GPL	license	and	a	freeware	DynamicPAD	builder	for	32-bit	Windows.	The	primary	way	to	consume	or	submit	a	DynamicPAD	file	is	through	the	RoboSoft	application	by	Rudenko
Software,	the	DynamicPAD	author.	DynamicPAD	is	available	at	the	DynamicPAD	web	site.Code	signing	is	a	technology	that	is	used	by	developers	to	digitally	sign	their	products.	Versions	of	Microsoft	Windows	since	Windows	XP	Service	Pack	2	show	a	warning	when	the	user	installs	unsigned	software.	This	is	typically	offered	as	a	security	measure	to
prevent	untrusted	software	from	potentially	infecting	the	machine	with	malware.	However,	critics	see	this	technology	as	part	of	a	tactic	to	delegitimize	independent	software	development	by	requiring	hefty	upfront	fees	and	a	review	process	before	software	can	be	distributed.[33]Association	of	Software	ProfessionalsCarewareKeygen^	Bink,	Thomas
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Software	Developers	Forum	(ISDEF)Retrieved	from	"	2Video	game	publisher"Apogee	Software"	redirects	here.	For	the	company	founded	in	2008,	see	Apogee	Entertainment.3D	Realms	Entertainment	ApSFormerlyApogee	Software	ProductionsApogee	Software,	Ltd.Company	typeSubsidiaryIndustryVideo	gamesFounded1987;	38years	ago(1987)	in
Garland,	Texas,	USFounderScott	MillerHeadquartersAalborg,	DenmarkKey	peopleFrederik	Schreiber	(CEO)ProductsList	of	3D	Realms	gamesParentSaber	Interactive	(2021present)Website3drealms.com3D	Realms	Entertainment	ApS	is	a	video	game	publisher	based	in	Aalborg,	Denmark.	Scott	Miller	founded	the	company	in	his	parents'	home	in
Garland,	Texas,	in	1987	as	Apogee	Software	Productions	to	release	his	game	Kingdom	of	Kroz.	In	the	late	1980s	and	early	1990s,	the	company	popularized	a	distribution	model	where	each	game	consists	of	three	episodes,	with	the	first	given	away	free	as	shareware	and	the	other	two	available	for	purchase.	Duke	Nukem	was	a	major	franchise	created
by	Apogee	to	use	this	model,	and	Apogee	published	Commander	Keen	and	Wolfenstein	3D	the	same	way.Apogee	began	using	the	brand	name	3D	Realms	for	its	3D	games	in	1994,	and	in	1996	rebranded	the	company	itself	to	3D	Realms	to	focus	on	traditionally-published	3D	titles.	Duke	Nukem	3D	(1996)	was	released	under	this	name	to	great	success.
3D	Realms	largely	ceased	its	publishing	and	development	operations	afterwards	to	focus	on	two	extensively	delayed	games:	Prey	(2006),	which	was	under	development	until	being	taken	over	by	another	studio	in	2001,	and	Duke	Nukem	Forever	(2011),	which	remained	under	development	until	2009.	The	"Apogee	Software"	name,	library,	and	logo
were	licensed	to	Terry	Nagy	in	2008,	who	established	Apogee	Software	LLC	to	develop	and	publish	ports	and	spinoffs	of	Apogee	titles.In	2009,	3D	Realms,	citing	financial	issues,	laid	off	its	development	team	and	the	majority	of	its	staff,	effectively	ceasing	operations.	In	March	2014,	the	company	was	acquired	by	SDN	Invest,	a	Danish	holding
company	and	part-owner	of	Interceptor	Entertainment,	and	relaunched	later	that	year	as	3D	Realms	Entertainment	ApS,	headquartered	in	Denmark.	3D	Realms	Entertainment	has	since	served	as	a	games	publisher.	Miller	remained	an	advisor	for	the	company	until	2021,	when	he	and	Nagy	acquired	the	Apogee	brand	and	relaunched	Apogee	Software
LLC	as	Apogee	Entertainment,	an	independent	games	publisher.	In	August	2021,	3D	Realms	Entertainment	was	acquired	by	Embracer	Group	subsidiary	Saber	Interactive,	which	was	spun	off	from	Embracer	in	March	2024.In	the	early	1980s,	Scott	Miller	often	spent	time	in	the	computer	lab	of	the	high	school	he	was	attending,	programming	text
adventures	on	the	facility's	Apple	II	and	getting	to	know	fellow	student	George	Broussard.[1]	Following	graduation,	both	of	them	took	jobs	at	local	amusement	arcade	The	Twilight	Zone,	allowing	Miller	to	attend	college	and	increase	his	interest	in	video	games	at	the	same	time.[1]	Following	his	sophomore	year,	Miller	dropped	out	of	the	University	of
Dallas	to	focus	entirely	on	video	games,	including	participating	in	tournaments	as	well	as	programming	his	own	games.[1]	At	that	time,	he	found	a	special	interest	in	the	Turbo	Pascal	programming	language	and	its	easy	integration	on	IBM	Personal	Computers.[2]	Miller	subsequently	figured	that	his	knowledge	on	video	games	should	earn	him	more
money	than	he	made	at	The	Twilight	Zone,	wherefore	he,	with	assistance	by	Broussard,	wrote	a	manual-style	book	on	"how	to	beat	video	games".[1]	The	book	fell	into	obscurity	due	to	an	oversaturated	market	but	landed	Miller	a	job	as	a	video	game	critic	for	The	Dallas	Morning	News	and	minor	game-centric	papers.[1]	After	four	years	of	writing	for
the	newspaper,	he	decided	that	he	was	capable	of	creating	games	that	were	better	than	those	that	he	had	to	review	and	quit	his	job.	Miller	acquired	a	16.5k	modem,	which	he	installed	in	his	parents'	house	in	Garland,	Texas,	and	started	operating	as	a	full-time	independent	game	developer.[1]The	Apogee	Software	logoMost	games	developed	by	Miller
at	the	time	used	extended	ASCII	characters	as	graphics.[1][3]	The	format	appeared	popular	to	him	but	ultimately	proved	unsuccessful	when	pitching	them	to	publishers,	adding	to	him	not	having	a	college	degree	or	any	professional	experience	in	game	development.[1]	As	such,	he	considered	self-printing	copies	of	his	games,	or	distributing	them
freely	through	bulletin	board	systems	(BBS),	where	the	boards'	users	make	voluntary	donations,	a	model	known	as	shareware	distribution.[1]	As	the	prior	option	seemed	too	expensive	to	Miller,	he	had	to	choose	the	latter,	despite	being	urged	not	to	by	friends	and	colleagues.[1]	Miller	released	Beyond	the	Titanic	and	Supernova	as	shareware	games	in
1986	and	1987,	respectively,	but	income	was	low,	at	roughly	US$10,000	donated	in	a	year	for	both	games	combined.[1]	Miller's	next	game,	Kingdom	of	Kroz,	was	developed	to	include	60	levels,	more	than	what	he	wanted	to	release	to	the	public	for	no	cost.[1]	As	such,	he	developed	a	new	distribution	model,	dubbed	the	"Apogee	model",	in	which	only
a	fraction	of	the	game	would	be	made	available	to	play	for	free	on	BBS,	which,	upon	completion,	would	display	Miller's	mailing	address	to	the	player	and	ask	them	to	contact	him	to	buy	the	rest	of	the	game.[1]	He	applied	this	model	to	Kingdom	of	Kroz	by	breaking	it	up	into	three	parts,	named	episodes,	and	sharing	the	first	one	over	BBS	while
retaining	the	other	two	for	sale.[1][2]	Released	on	November	26,	1987,	Kingdom	of	Kroz	was	the	first	game	to	bear	the	name	of	Miller's	one-man	company,	Apogee	Software	Productions.[2]	The	game	proved	successful,	with	checks	sent	to	Miller	amounting	to	roughly	US$80,000US$100,000	and	him	receiving	between	US$100	and	US$500	every
single	day.[2]	Broussard	later	joined	Apogee,	merging	his	own,	lesser-known	game	company	Micro-FX	into	it.[4]In	1994,	Apogee	decided	to	launch	different	brand	names	for	each	genre	of	games	they	published;	it	created	3D	Realms	for	3D	games,	publishing	Terminal	Velocity	in	1995	and	developing	the	1996	Duke	Nukem	3D	under	the	name,	with	the
other	titles	released	in	those	years	still	under	Apogee.[5]	In	late	1996,	however,	Apogee	renamed	the	company	itself	to	3D	Realms	to	associate	their	brand	with	newer,	3D	titles,	and	stopped	using	the	Apogee	brand	name.[6]	The	last	game	to	be	published	under	the	Apogee	name	was	Stargunner	in	1996.	Most	of	the	proposed	brands	were	never	used,
as	3D	games	like	Duke	Nukem	became	the	company's	focus.	3D	Realms	launched	a	brand	for	pinball	games,	Pinball	Wizards,	in	February	1997,	but	only	published	Balls	of	Steel	(1997)	under	the	name.[5]	Beginning	in	1997	3D	Realms	shifted	from	episodic	MS-DOS	titles	to	non-episodic	console	and	personal	computer	games.	In	the	process	it
abandoned	the	shareware	model	in	favor	of	a	traditional	publishing	model;	it	also	largely	ceased	its	activities	as	a	developer	that	same	year,	releasing	only	Shadow	Warrior	(1997).[7]	The	sole	exceptions	were	Prey	(2006),	which	stayed	in	development	until	2001	when	it	was	transferred	to	Human	Head	Studios,	and	Duke	Nukem	Forever	(2011),	which
famously	stayed	in	development	at	3D	Realms	as	vaporware	until	2009.[7][8]The	"Apogee	Software"	name,	library,	and	logo	were	licensed	to	Terry	Nagy	in	2008,	who	formed	Apogee	Software,	LLC	as	a	separate	company	that	would	handle	distribution,	remakes,	and	other	developments	related	to	older	Apogee	games.	3D	Realms	retained	the
corporate	name	of	Apogee	Software,	Ltd.	Apogee	Software,	LLC	was	renamed	Apogee	Entertainment	in	2021.[6]After	Prey	was	transferred	away	from	3D	Realms	in	2001,	the	only	project	under	development	at	the	company	was	Duke	Nukem	Forever,	originally	announced	in	1997.	The	release	date	of	the	game	was	"when	it's	done."[9]	3D	Realms
continued	some	operations	as	a	publisher	as	part	of	the	Gathering	of	Developers	publishing	group,	but	otherwise	served	only	as	the	publisher	and	licensee	of	Duke	Nukem-related	spinoffs	and	mobile	games	for	the	next	few	years.	On	May	6,	2009,	the	development	of	Duke	Nukem	Forever	was	halted,	and	major	staff	cuts	were	initiated	with	the	entire
development	team	and	most	other	employees	laid	off.[10][11]	According	to	Miller,	the	development	was	using	up	much	of	the	company's	funds	as	they	struggled	to	bring	in	new	3D	rendering	technology	for	the	game,	leading	to	the	decision	to	cut	their	staff	and	sell	the	company.[12]On	May	14,	2009,	Take-Two,	holders	of	the	publishing	rights	of	Duke
Nukem	Forever,	filed	a	breach	of	contract	suit	against	3D	Realms	over	failing	to	deliver	the	game.[13]	Take-Two	Interactive	asked	for	a	restraining	order	and	a	preliminary	injunction,	to	make	3D	Realms	keep	the	Duke	Nukem	Forever	assets	intact	during	proceedings.[14][15]	On	May	18,	2009,	3D	Realms	key	executives	announced	that	"3D	Realms
has	not	closed	and	is	not	closing",	but	that	due	to	lack	of	funds	development	operations	were	ceasing	and	the	company	would	continue	to	"license	and	co-create	games	based	upon	the	Duke	Nukem	franchise."	They	accused	Take-Two	of	trying	to	acquire	the	Duke	Nukem	franchise	in	a	"fire	sale".[11]On	September	3,	2010,	Take-Two	Interactive
announced	that	development	of	Duke	Nukem	Forever	had	been	shifted	over	to	Gearbox	Software,	effectively	ending	3D	Realms'	association	with	the	game	after	12	years	of	development.	3D	Realms	remained	credited	as	a	co-developer	on	Duke	Nukem	Forever,	due	to	their	involvement	in	developing	most	of	the	game.	The	rights	and	intellectual
property	were	sold	to	Gearbox,	however,	who	became	the	owners	of	the	Duke	Nukem	franchise.[16]An	external	developer,	Interceptor	Entertainment,	started	work	on	a	fan-project	remake	of	Duke	Nukem	3D	in	2010.	They	received	a	limited	authorization	from	Gearbox	to	proceed	with	the	game,	which	was	named	Duke	Nukem	3D:	Reloaded.
However,	after	Duke	Nukem	Forever's	release	and	negative	reception	in	2011,	Duke	Nukem	3D:	Reloaded	was	put	on	hold	indefinitely.In	an	interview	conducted	with	Scott	Miller	in	April	2011,	Miller	specified	that	3D	Realms	was	involved	with	several	projects:	"we	have	several	projects	underway,	all	fairly	smallnot	any	big	console	games.	Once	[Duke
Nukem	Forever]	comes	out	we'll	be	definitely	looking	to	invest	into	other	projects,	and	maybe	other	up-n-coming	[sic]	teams	who	are	blazing	new	trails	on	smaller	platforms,	like	smart	phones	and	XBLA."[17]	3D	Realms	did	not	publish	any	released	titles	over	the	next	few	years,	however.In	June	2013,	3D	Realms	sued	Gearbox	for	unpaid	royalties	as
well	as	unpaid	money	for	selling	the	Duke	Nukem	intellectual	property.[18]	The	lawsuit	was	dropped	in	September	2013	with	3D	Realms	apologizing	with	an	announcement	that	they	had	resolved	any	differences	they	had	with	Gearbox.	In	February	2014,	Gearbox	sued	3D	Realms,	Interceptor	Entertainment	and	Apogee	Software,	LLC	for	developing	a
new	game	called	Duke	Nukem:	Mass	Destruction.	Gearbox	stated	that	it	was	still	the	rights	holder	of	the	Duke	Nukem	franchise,	and	permission	had	not	been	granted	by	them	to	develop	the	game.	3D	Realms	soon	after	released	a	statement	admitting	its	wrongdoing.[19]	The	lawsuit	was	settled	in	August	2015,	with	Gearbox	stressing	that	it	was	still
the	lawful	owner	of	the	Duke	Nukem	intellectual	property.[20]In	March	2014,	SDN	Invest,	the	part-owner	of	Interceptor	Entertainment,	acquired	3D	Realms	for	an	undisclosed	sum.[21]	Mike	Nielsen,	the	founder	and	chairman	of	SDN	Invest,	became	the	new	chief	executive	officer	of	3D	Realms,[22]	headquartered	in	Aalborg,	Denmark	and
incorporated	in	2015	as	3D	Realms	Entertainment	ApS.[23][24]	Miller	remained	with	the	company	as	a	creative	consultant,[25]	while	Apogee	Software	LLC	retained	the	license	to	the	Apogee	brand	and	library.[26]In	May	2014,	3D	Realms	announced	they	were	to	publish	Bombshell	by	Interceptor	Entertainment,[27]	and	in	October	2014	the	company
returned	to	distributing	its	own	titles	with	a	digital	anthology	collection.[28][29]	Bombshell	was	released	on	January	29,	2016,	as	3D	Realms'	first	published	title	since	2005.On	February	28,	2018,	3D	Realms	announced	the	game	Ion	Maiden,	a	prequel	to	Bombshell,	developed	by	Voidpoint	and	using	Ken	Silverman's	Build	Engine.	In	May	2019,	the
company	was	hit	with	a	$2	million	trademark	infringement	lawsuit	by	heavy	metal	group	Iron	Maiden	who	claimed	Ion	Maiden	was	"nearly	identical	to	the	Iron	Maiden	trademark	in	appearance,	sound	and	overall	commercial	impression"	and	was	"attempting	to	trade	off	on	Iron	Maiden's	notoriety."[30]	In	July	2019,	3D	Realms	and	Voidpoint	changed
the	name	of	Ion	Maiden	to	Ion	Fury	to	end	to	the	lawsuit.	Ion	Fury	was	released	on	August	15,	2019.	Since	then,	3D	Realms	published	Ghostrunner	(2020)	and	announced	several	projects	which	have	been	under	development	for	multiple	years	without	further	notice.[31]In	April	2021,	Miller	and	Nagy	acquired	the	Apogee	name	from	3D	Realms	and
relaunched	Apogee	Software	LLC	as	Apogee	Entertainment.[32]	In	2022,	Miller	stated	in	a	blog	post	that	he	was	now	uninvolved	with	3D	Realms	and	that	"[the	company]	no	longer	has	any	link	to	the	past,	other	than	in	name	only"	because	he	was	no	longer	there	to	help	design	and	fund	games.[33]In	August	2021,	Embracer	Group	announced	that
they	acquired	the	company	through	Saber	Interactive,	which	will	be	the	parent	company.[34]	3D	Realms	published	Cultic	on	October	13	(2022).In	March	2023,	3D	Realms	announced	that	they	hired	Justin	Burnham	(formerly	of	Devolver	Digital,	Good	Shepherd)	to	the	position	of	CCO.[35]On	September	30,	2023,	3D	Realms	held	its	4th	annual	Realms
Deep	event	modernizing	the	company's	branding	and	announcing	release	dates	for	several	previously-unreleased	titles.	Two	days	later	on	October	2,	they	published	Ion	Fury:	Aftershock	in	collaboration	with	developer	Voidpoint.[36]	On	October	24,	2023,	3D	Realms	published	Ripout	into	early	access	in	collaboration	with	developer	Pet	Project	Games.
[37]	On	November	16,	3D	Realms	published	The	Kindeman	Remedy	in	collaboration	with	developer	Troglobyte	Games.[38]	On	December	5,	2023,	3D	Realms	co-published	(with	Interplay)	the	Slipgate	Ironworks-developed	Kingpin	Reloaded.[39]	In	mid-December,	"at	least	half"	of	3D	Realms	and	Slipgate	Ironworks	was	laid	off	as	part	of	Embracer's
restructuring.[40]	Layoffs	continued	into	January	2024.[41]On	January	24,	2024,	3D	Realms	co-published	(with	Fulqrum	Publishing)	the	Slipgate	Ironworks-developed	Graven	out	of	early	access.[42]	On	February	27,	3D	Realms	co-published	(with	Fulqrum	Publishing)	the	Slipgate	Ironworks	and	Killpixel	Games-developed	Wrath:	Aeon	of	Ruin	out	of
early	access.[43]In	March	2024,	Saber	Interactive	was	sold	to	Beacon	Interactive,	a	new	company	from	Saber	co-founder	Matthew	Karch.	Many	of	Saber's	studios,	including	3D	Realms,	were	included	in	the	sale.[44]Main	article:	List	of	3D	Realms	games^	a	b	c	d	e	f	g	h	i	j	k	l	m	n	Plante,	Chris	(October	26,	2017).	"Apogee:	Where	Wolfenstein	got	its
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Go	to	Edit	>	Insert	>	Page	from	File,	and	choose	PDF	files	from	your	computer.	When	you	need	to	merge	multiple	files,	just	hold	down	the	Command	key	and	select	multiple	files	to	open	them.	Under	the	File	menu,	click	on	Saveto	download	your	combined	file.	Thoughtful	Tips	for	You:If	the	number	of	pages	in	the	file	to	be	merged	is	relatively	small,
you	can	simply	drag	the	pages	to	another	file.	Looking	for	Ways	to	Combine	PDF	Files	Online	Free?	Free	online	is	a	buzzword	in	Google	search.	After	all,	many	users	just	need	to	solve	few	PDF	problems	at	hand,	and	free	online	websites	are	the	quickest	and	most	time-saving	tools.	Here	we	pick	2	popular	online	free	PDF	file	combiners	for	users	who
have	the	need	to	merge	large	PDF	files.	#1.	Google	Drive	Google	Drive	is	a	file	storage	and	synchronization	service	created	by	Google,	which	provides	15	GB	free	storage	for	users.	Google	Drive	is	a	vital	part	of	Google	Workspace.	Actually,	the	method	of	merging	files	we	will	use	in	this	part	is	getting	add-ons	in	Google	Workspace	Marketplace.	How
to	Combine	PDF	Files	Online	in	Google	Drive?	Enter	the	website	of	Google	Drive	and	log	in	to	your	Google	account.	Click	the	Get	Add-ons	icon	on	the	right-sidebar.	Type	PDF	Merge	and	Split	in	the	search	bar	and	install	the	extension	in	your	Google	Drive.	Click	+	New	>	File	upload	to	import	PDF	files	to	be	combined.	Right-click	a	PDF	file	and	go	to
Open	with	>	PDF	Merge	and	Split.	Select	more	files	from	Google	Drive	or	choose	files	from	the	local	device.	Rename	the	combined	PDF	and	click	Create	PDF	to	combine	PDF	files	without	Adobe	smoothly.	#2.	Adobe	Acrobat	A	majority	of	people	who	don't	want	to	use	Adobe	are	put	off	by	its	price	and	complex	interface,	and	if	so,	its	online	PDF
merger	is	a	good	option	for	you.	It	allows	you	to	upload	multiple	PDF	files	and	merge	them	into	one	in	a	few	clicks.	How	to	Combine	PDF	Files	with	Adobe	Acrobat?	Search	Adobe	Acrobat	online	tool	in	Google	browser	and	find	its	Merge	PDFs	feature.	Drag	and	drop	PDF	files	into	this	online	PDF	merger.	Tick	the	boxes	next	to	the	PDF	files	you	want	to
combine.	If	you	want	to	add	more	PDF	files,	choose	Insert	files	icon	on	the	top	to	import.	When	everything	is	done,	click	Merge	at	the	top	right	to	start	merging	PDF	files	Online	Free.	Final	Thoughts	Most	of	the	recommendations	in	this	article	are	free	PDF	file	combiners.	But	in	fact,	only	Cisdem	PDFMaster	and	PDFsam	Basic	are	professional	PDF
managers	and	enable	more	options	to	adjust	when	combine	PDF	files.	If	you	have	higher	requirements	for	processing	PDF	files,	Cisdem	PDFMaster	is	the	top	choice	for	you.	An	all-in-one	editor	that	integrates	editing,	merging,	splitting,	converting,	annotating,	compressing,	and	protecting,	for	both	novices	and	professionals.	Bianca	is	a	senior	tech
editor	and	strategist	at	Cisdem	with	Over	10	years	of	experience	on	PDF	related	solutions	which	covers	all	document	editing,	annotating,	converting	and	managing	etc.	Can	I	combine	multiple	PDFs	into	one	for	free	and	safely?	Is	it	even	possible	to	do	this	without	Acrobat?	So,	youre	in	a	situation	where	you	need	to	combine	multiple	PDFs	into	one
PDF,	but	you	dont	have	Adobe	Acrobat.	Well,	the	good	news	is	yes,	its	entirely	possible	to	combine	PDF	files	without	Acrobat	and	there	are	several	ways	to	do	it	that	are	both	online,	free,	and	safe.	Whether	you	need	to	do	it	on	your	computer,	through	an	online	service,	or	without	any	software,	there	are	plenty	of	options	out	there.	In	this	article,	well
explore	how	to	combine	PDF	files	without	Acrobat.	Adobe	Acrobat's	premium	features	can	be	expensive.	If	you're	looking	for	a	free,	secure,	and	easy-to-use	solution,	Tenorshare	PDNob	is	a	powerful	alternative.	This	all-in-one	PDF	tool	allows	you	to	combine	PDFs	effortlessly,	while	also	offering	PDF	conversions	(PDF	to	Word,	Excel,	PPT,	EPUB,	and
more)	and	100+	advanced	editing	features,	including	text	editing,	watermarking,	image	insertion,	background	customization,	and	PDF	protection.	With	PDNob	PDF	Editor,	you	can	merge	PDFs	in	just	a	few	clicks	without	quality	loss,	ensuring	that	all	content	remains	intact.	Whether	you	need	to	combine	invoices,	business	documents,	or	personal	files,
this	tool	makes	the	process	seamless	and	efficient.	More	importantly,	the	free	trial	of	PDNob	is	long-term.	Advantages	of	Tenorshare	PDNob	PDF	Editor:Free	&	Secure	PDF	Merging	No	need	for	costly	subscriptions;	merge	PDFs	without	file	size	restrictions.Multiple	Conversion	Options	Convert	PDFs	to	Word,	Excel,	PowerPoint,	EPUB,	PNG,	JPEG,	and
more.100+	Editing	Features	Modify	text,	insert	images,	add	watermarks,	and	customize	backgrounds.Cross-Platform	Compatibility	Works	on	Windows	and	Mac	for	seamless	document	management.No	Quality	Loss	Ensures	merged	PDFs	retain	original	formatting	and	clarity.	Steps	to	Combine	Multiple	PDFs	into	One	with	Tenorshare	PDNobLaunch



PDNob	PDF	Editor	from	your	desktop,	and	click	Batch	tools.	Click	on	the	"Merge"	button	to	browse	and	select	multiple	PDF	files	you	want	to	merge.	You	can	add	multiple	PDFs	at	once.	Click	the	"Merge"	or	similar	button	to	start	the	merging	PDF	files	process.	After	the	PDFs	are	merged,	you'll	be	prompted	to	save	the	new,	combined	PDF	file	to	your
desired	location.	If	youre	looking	for	an	online	solution	to	combine	PDFs	into	one,	there	are	several	free	web	tools	available.	One	popular	and	trusted	option	is	Smallpdf.	Its	a	convenient	online	tool	that	allows	you	to	merge	PDFs	without	Acrobat	quickly	and	securely,	without	needing	to	download	or	install	anything.Steps	to	Merge	PDF	Files	without
Acrobat	on	Smallpdf:	Visit	the	SmallPDF	website	using	the	provided	link.Click	CHOOSE	FILES	and	select	the	PDF	documents	you	want	to	merge.Click	Merge	files	if	you	are	using	the	free	version.	If	you	have	the	Pro	version,	you	can	merge	individual	pages	before	clicking	Choose	option.Review	your	selected	PDFs.	If	you	want	to	add	more,	click	ADD
MORE;	otherwise,	click	MERGE	PDF	to	combine	them.Once	the	merging	is	complete,	click	Download	to	save	the	merged	PDF	to	your	computer.	When	to	Use	Online	Tools:	Online	tools	like	Smallpdf	are	perfect	for	quick,	one-time	tasks	where	you	need	to	merge	PDFs	fast.	However,	they	may	not	be	suitable	for	sensitive	documents	since	youre
uploading	your	files	to	a	third-party	server.	Fast	and	Easy:	No	installation	required,	and	the	process	is	quick.	Free	for	Basic	Use:	You	can	merge	PDFs	for	free	with	no	sign-up	necessary.	Safe:	Smallpdf	claims	to	delete	uploaded	files	within	an	hour	for	privacy.	File	Size	Limits:	Theres	a	maximum	file	size	for	free	users.	Privacy	Concerns:	Since	your
files	are	uploaded	to	a	third-party	server,	theres	a	small	risk	if	youre	dealing	with	sensitive	data.	Ads:	Free	users	might	encounter	ads.	If	youre	a	Windows	user,	did	you	know	how	to	combine	PDF	files	without	acrobat?	Microsoft	Print	to	PDF	is	an	often-overlooked	feature	of	Windows	10	that	can	help	you	how	to	combine	pdf	files	without	acrobat	on
windows	10	without	any	additional	software	or	third-party	tools.How	to	Use	Microsoft	Print	to	Merge	PDFs	into	One:Open	a	blank	Microsoft	Print	to	PDF.Go	to	the	Insert	tab	and	click	Object	from	the	dropdown	menu.In	the	Object	dialog	box,	select	Create	from	File,	then	click	Browse	to	choose	the	first	PDF	file.	Check	the	Display	as	Icon	box	to	insert
a	PDF	icon	representing	the	file.Repeat	steps	3	and	4	to	add	more	PDFs.Click	OK	to	insert	all	selected	PDFs	into	your	Word	document.	No	Extra	Software	Needed:	This	is	a	built-in	feature	of	Windows	10,	so	you	dont	need	to	download	anything.	Secure:	Since	the	merging	happens	entirely	on	your	local	machine,	its	safer	for	sensitive	documents.
Manual	Process:	You	need	to	print	each	PDF	in	order.	Its	not	as	automated	as	other	options.	Limited	Features:	While	functional,	it	doesnt	offer	the	same	range	of	options	as	dedicated	software.	Combining	multiple	PDF	files	into	a	single	PDF	document	is	a	common	task,	especially	for	Mac	users	who	want	a	quick	and	free	solution	without	relying	on
Adobe	Acrobat.	Fortunately,	macOS	includes	a	built-in	app	called	Preview	that	allows	users	to	merge	PDFs	seamlessly.	Open	the	first	PDF	file:	Locate	your	PDF	files	in	Finder,	right-click	the	first	one,	select	Open	With,	and	choose	Preview.	Display	thumbnails:	In	Previews	top	menu,	click	View	>	Thumbnails	to	show	page	thumbnails	in	the	sidebar.
This	makes	it	easier	to	manage	pages.	Add	more	PDFs:	Open	the	second	PDF	(and	others	if	needed)	in	separate	Preview	windows.	Drag	the	thumbnails	of	the	pages	you	want	to	add	from	the	second	PDFs	sidebar	into	the	sidebar	of	the	first	PDF.	You	can	drag	entire	PDFs	or	select	specific	pages	by	Command-clicking	them.	Rearrange	pages:	Drag	the
thumbnails	up	or	down	within	the	sidebar	to	reorder	pages	as	desired.	Save	the	combined	PDF:	When	finished,	go	to	File	>	Export	as	PDF	(or	simply	Save)	to	create	a	new	PDF	that	contains	all	merged	pages.	Tips:	To	preserve	the	original	files,	use	File	>	Duplicate	before	merging,	as	Preview	saves	changes	automatically.	Free	and	built	into	macOS,
no	extra	installation	needed	Simple	drag-and-drop	interface	for	merging	and	rearranging	pages	Ideal	for	quick	merging	of	a	small	number	of	PDF	files	No	batch	processing,	so	merging	many	files	can	be	time-consuming	Lacks	advanced	features	like	annotations	or	digital	signatures	Saving	sometimes	slightly	affects	file	size	or	quality	Yes,	there	are
many	free	online	tools	and	software	like	Tenorshare	PDNob	PDF	Editor	that	allow	you	how	to	combine	PDF	files	without	acrobat.Can	I	combine	PDFs	on	Mac	without	Acrobat?Yes,	you	can	use	free	tools	like	Preview	(built-in	on	Mac),	or	third-party	applications	like	Tenorshare	PDNob	PDF	Editor	to	combine	PDFs	on	Mac	without	needing	Acrobat.How
do	I	combine	multiple	PDF	files	into	one	without	losing	quality?To	maintain	quality	while	combining	PDFs,	use	PDNob	PDF	Editor,	which	lets	you	merge	PDF	files	while	preserving	the	original	content.	Avoid	using	low-quality	online	tools	that	may	degrade	the	PDFs.	Combining	PDF	files	without	Acrobat	is	easier	than	ever,	and	you	dont	need	to	spend
money	on	expensive	software.	From	powerful	tools	like	Tenorshare	PDNob	PDF	Editor	to	free	online	services	like	Smallpdf	and	even	built-in	options	on	Windows	10/Mac,	there	are	plenty	of	ways	to	merge	PDFs	into	one	without	Acrobat.	If	you	want	a	full-featured	and	reliable	PDF	editor,	Tenorshare	PDNob	is	a	great	choice	for	handling	PDF	merging
and	much	more.	Its	free	for	basic	use	and	offers	a	safe,	user-friendly	experience	thats	perfect	for	both	occasional	and	frequent	PDF	users.	The	END	I	am	PDNob.	Swift	editing,	efficiency	first.	Make	every	second	yours:	Tackle	any	PDF	task	with	ease.	As	Leonardo	da	Vinci	said,	"Simplicity	is	the	ultimate	sophistication."	That's	why	we	built	PDNob.
Registrer/	Login	then	write	your	review	Download	Article	Learn	free	and	easy	ways	to	merge	PDF	files	online	or	on	your	computer.	Download	Article	Combining	the	contents	of	two	or	more	PDF	files	is	easy,	even	if	you	don't	have	Adobe	Acrobat.	Many	free	apps	are	capable	of	merging	PDF	files	together.	You	can	do	it	online	using	a	wide	variety	of
tools,	including	Adobes	free	PDF	Combiner.	You	can	also	do	it	on	your	desktop	PC	with	a	free	third-party	app	like	PDF	Merger	&	Splitter,	or	with	built-in	tools	like	Finder	and	Preview	on	Mac.	This	tutorial	will	teach	you	quick	and	easy	ways	to	merge	several	PDF	files	into	a	single	document.	1	2Drag	and	drop	the	files	you	want	to	merge.	Locate	the
PDF	files	you	want	to	combine	on	your	computer,	then	drag	and	drop	them	into	the	PDF	Combiner	window.	Place	the	files	in	the	area	where	you	see	the	message	Drag	and	drop	PDFs	to	merge	them	into	one	file	with	our	PDF	combiner.You	can	also	click	the	blue	Select	files	button.	A	File	Explorer	(Windows)	or	Finder	(Mac)	window	will	open	where
you	can	browse	for	and	select	the	PDFs	you	want	to	merge.	Advertisement	3Reorder	the	files	if	you	want.	If	you	want	to	change	the	order	of	the	different	PDFs	within	the	merged	document,	simply	click	and	drag	them	to	your	preferred	order	in	the	window.	You	can	also	add	or	remove	PDF	files	from	the	list.To	remove	a	file,	hover	over	it	and	then	click
the	trash	can	icon.To	add	more	files,	click	the	icon	at	the	top	of	the	merger	window	that	looks	like	a	document	with	a	+	in	the	bottom	right	corner.4Click	Merge.	Youll	see	this	blue	button	at	the	top	right	corner	of	the	PDF	Combiner	window.5Click	Download.	Once	the	files	are	finished	processing,	this	button	will	appear	on	the	left	side	of	the	page.	By
default,	the	merged	file	will	save	to	your	Downloads	folder.	Advertisement	1Download	PDF	Merger	&	Splitter.	PDF	Merger	&	Splitter	is	a	free	app	that	allows	you	to	merge	PDFs	and	extract	pages	from	a	PDF.	You	can	download	PDF	Merger	&	Splitter	for	free	from	the	Microsoft	Store.[1]	Use	the	following	steps	to	download	PDF	Merger	&
Splitter:Click	the	Windows	Start	menu.Click	the	Microsoft	Store	icon,	which	resembles	a	white	shopping	bag.Click	Search	in	the	upper-right	corner.Type	"PDF	Merger	&	Splitter"	in	the	search	bar.Click	PDF	Merger	&	Splitter.Click	GET.There	are	lots	of	similar	apps	available,	and	they	all	work	similarly.	Other	free	options	include	PDFsam	Basic,
Merge	PDF	Free,	and	Merge	PDF	PLUS.2Open	PDF	Merger	&	Splitter.	PDF	Merger	&	Splitter	has	an	icon	that	resembles	a	page.	You	can	find	it	in	the	Windows	Start	menu,	or	you	can	click	Launch	in	the	Microsoft	Store	once	it	finishes	downloading.3Click	Merge	PDF.	It's	the	first	purple	button	in	the	center	of	the	page.4Click	Add	PDFs.	It's	the	first
option	in	the	upper-left	corner.	This	option	opens	File	Explorer	and	allows	you	to	browse	for	PDFs.5Navigate	to	the	location	of	the	PDFs	you	want	to	merge.	Use	File	Explorer	to	navigate	to	the	location	of	the	PDFs	you	want	to	merge.	Double-click	the	folder	the	PDFs	are	located	in	to	navigate	to	that	folder.6Select	the	PDFs	and	click	Open.	You	can
select	more	than	one	file	at	a	time	by	holding	the	Ctrl	button	and	clicking	the	files	you	want	to	open.	Then	click	Open	in	the	lower-right	corner.Click	Add	PDFs	again	to	upload	additional	PDF	files.To	change	the	order	of	the	PDFs,	click	the	PDF	file	you	want	to	move	in	the	list,	and	click	Move	Up	or	Move	Down	above	the	list.To	remove	a	PDF,	click	the
PDF	you	want	to	remove	and	click	Remove	above	the	list.7Click	Merge	PDFs.	It's	in	the	lower-right	corner.	This	displays	a	Save	prompt	that	you	can	use	to	save	the	merged	PDFs.8Type	a	name	for	the	merged	PDF.	Use	the	field	next	to	"Filename"	to	type	a	name	for	the	merged	PDF.You	can	also	select	a	location	to	save	the	file	to.9Click	Save.	This
saves	your	PDFs	as	a	single,	merged	PDF.	Advertisement	1Open	a	Finder	window.	Click	the	Finder	icon	in	the	Dock	to	open	a	new	Finder	window.	Navigate	to	the	location	of	the	PDF	files	you	want	to	merge.2Click	the	Gallery	tab.	At	the	top	of	the	Finder	window,	click	the	tab	that	looks	like	a	rectangle	with	a	row	of	squares	underneath.	This	will
switch	you	to	Gallery	view.You	can	also	click	View	in	the	menu	bar	at	the	top	of	your	screen,	then	select	as	Gallery.3Command-click	the	PDFs	you	want	to	merge.	Hold	down	the	command	key	while	clicking	on	any	PDF	files	you	want	to	combine.	Select	the	files	in	the	order	in	which	you	want	them	to	appear	in	the	merged	PDF.4Click	Create	PDF.	Once
youve	selected	two	or	more	PDF	files,	a	button	will	appear	in	the	right	panel	that	says	Create	PDF.	Click	this	button	to	merge	your	files.	The	new	PDF	will	be	saved	to	your	Desktop.You	can	also	select	the	files	you	want	to	merge	in	List	view,	then	control-click	them	and	select	Quick	Actions	>	Create	PDF.	Advertisement	1Launch	the	Preview	app.	The
icon	looks	like	a	snapshot	of	a	landscape	with	a	magnifier	in	front	of	it.2Open	the	PDF	files	you	want	to	merge.	In	Preview,	click	the	File	menu,	then	select	Open.	Navigate	to	the	location	of	your	PDF	files	and	open	them.You	can	select	multiple	files	at	once	by	command-clicking	them,	then	clicking	Open.You	can	also	navigate	to	the	PDF	files	you	want
to	open	in	Finder,	then	right-click	or	control-click	them	and	select	Open	With	>	Preview.3Duplicate	the	PDFs.	To	avoid	making	any	unwanted	permanent	changes	to	the	original	files	when	you	use	this	method,	you	may	want	to	make	copies	instead	of	working	with	the	originals.	To	do	this,	select	each	file,	then	click	the	File	menu	at	the	top	of	the
screen	and	select	Duplicate.4Open	one	of	the	duplicate	files.	It	doesnt	matter	which	one	you	start	with,	since	you	can	rearrange	order	of	the	pages	within	the	combined	file.5Enable	the	thumbnail	pane	in	the	View	menu.	If	you	dont	already	see	the	sidebar	that	shows	thumbnails	of	all	the	pages	in	your	PDF,	click	View	>	Thumbnails	in	the	menu	at	the
top	of	the	screen.	It	will	appear	on	the	left	side	of	the	PDF	window.6Drag	additional	PDFs	into	the	sidebar.	Click	any	of	the	other	PDF	files	you	want	to	merge	with	the	first	one	and	simply	drag	and	drop	them	into	the	thumbnail	bar	on	the	left	side	of	the	window.	Click	and	drag	thumbnails	to	change	the	order	of	the	pages.Want	to	merge	individual
pages	from	another	PDF	into	your	document?	Simply	open	the	other	PDF	in	preview,	make	sure	Thumbnails	is	enabled,	and	drag	the	thumbnails	of	the	desired	pages	over	to	the	sidebar	on	the	first	document.	Advertisement	1Open	Adobe	Acrobat.	Adobe	Acrobat	has	a	red	and	white	icon	with	a	red	looping	swoosh	in	the	middle.	Adobe	Acrobat	is
Adobe's	proprietary	(paid)	PDF	creation	and	editing	tool.	Youll	need	to	use	one	of	the	paid	versions	of	Adobe	Acrobat	(rather	than	the	free	Adobe	Acrobat	Reader	app)	to	merge	PDFs.Adobe	Acrobat	is	subscription-based,	but	Acrobat	Pro	offers	a	free	trial	option.2Click	Tools.	It's	the	second	tab	at	the	top.	This	displays	the	PDF	creation	tools.[2]3Click
Combine	Files.	It's	the	second	option	on	the	Tools	page.	It	has	a	purple	icon	that	resembles	two	pages.4Click	Add	Files.	It's	the	blue	button	in	the	center	of	the	pages.	This	opens	File	Explorer	on	Windows,	or	the	Finder	on	Mac.[3]5Navigate	to	the	location	the	PDFs	are	stored.	Use	the	File	Explorer	or	Finder	window	to	navigate	to	the	folder	the	PDFs
you	want	to	merge	are	saved	to.6Select	the	PDFs	you	want	to	merge.	To	select	multiple	files,	press	and	hold	Ctrl	on	Windows	or	Command	on	Mac.	Then	click	the	files	you	want	to	add.7Click	Open.	It's	in	the	lower-right	corner.	This	displays	all	the	PDFs	as	thumbnail	images	in	Adobe	Acrobat.To	add	additional	PDFs,	click	Add	Files	at	the	top	of	the
screen.Click	and	drag	the	thumbnail	images	in	Adobe	Acrobat	to	change	the	order	of	the	files.To	remove	a	PDF,	click	a	thumbnail	to	select	it	and	click	Remove	at	the	top	of	the	page.8Click	Combine.	It's	the	blue	button	at	the	top	of	the	page.	This	combines	all	the	PDFs	in	the	thumbnail	list	into	one	PDF.[4]9Click	File.	It's	in	the	menu	bar	at	the	top	of
Adobe	Acrobat.10Click	Save	as.	It's	in	the	drop-down	menu	below	"File"	in	Adobe	Acrobat.11Click	a	recent	save	location	or	click	Choose	a	different	folder.	You	can	select	one	of	the	recent	save	locations	listed,	or	click	the	blue	button	that	says	Choose	a	different	folder	to	select	a	different	save	location.12Type	a	name	for	the	merged	PDF.	Use	the	field
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common	PDF	tasks	you	need,	making	it	a	efficient	and	powerful	alternative	to	Adobe	Acrobat	on	your	desktop.Beyond	combining	PDF	files,	you	can	also	edit,	organize,	sign,	or	convert	PDFs	into	Word	without	Adobe	Acrobat.	Here's	how	to	combine	and	merge	PDF	files	using	Xodo	on	Android	and	iOS:	Install	the	Xodo	app	for	Android	or	iOS.	In	the
app,	tap	on	the	Toolbox	menu	at	the	bottom.SelectManage	PDF	>	Merge	Pages.Select	or	upload	the	PDF	files	you	wish	to	combine.	Tap	onNEXT.	Rearrange	the	order	of	your	PDF	files	in	the	merged	document	by	long-pressing	and	dragging	the	handles	next	to	each	file	name.Tap	onMERGE.The	Xodo	app	offers	many	free	tools	to	enhance	your
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the	best	tool	for	making	file	management	easier	and	faster.	How	do	I	combine	PDF	files	without	Acrobat	with	this	merger?	Follow	this	general	guide	to	combine	your	PDFs	without	Adobe:	01Download,	install,	and	run	Coolmuster	PDF	Merger	on	your	computer.	02Click	Add	Files	or	Add	Folder,	or	drag	and	drop	your	documents	to	upload	them	on	the
merger.	03Select	the	PDF	files	you	want	to	combine	without	Adobe	Acrobat.	Click	the	menu	button	under	Output	Folder	to	set	the	output	file's	destination	folder	on	your	computer.	Use	the	inbuilt	viewer	to	preview	your	PDF	files	before	merging.	04Click	Start	to	merge	the	PDF	files.	With	its	all-powerful	enhanced	engine,	Coolmuster	PDF	Mergers
allows	you	to	combine	PDF	files	without	Acrobat	fast	and	efficiently.	Part	2:	How	to	Combine	PDF	Files	Without	Adobe	Acrobat	[Mac]	If	you	don't	want	to	use	freeware	like	Adobe	to	combine	your	files	on	Mac,	you	can	sample	some	built-in	tools,	like	Preview	and	Finder.	With	these	built-in	functions,	you	don't	have	to	download	any	program	to	combine
files.	How	can	I	combine	PDF	files	without	Acrobat	on	my	Mac?	Find	out	how	below.	Method	1:	How	to	Merge	2	PDF	Files	Without	Acrobat	Using	Preview	Preview	is	a	Mac	built-in	file	viewer.	Unlike	Adobe	Acrobat,	Preview	doesn't	require	any	account	upgrades.	It	is	a	powerful	option	to	help	you	combine	PDF	files	without	using	Adobe	Acrobat.	Here
is	how	to	use	Preview	to	combine	multiple	PDF	files	without	Acrobat:	Step	1:	Create	a	copy	of	the	main	PDF	to	protect	it	in	case	of	loss.	Step	2:	Open	the	copied	file	with	the	Preview	app	on	your	Mac	and	drag	other	PDF	files	into	the	sidebar.	Drop	the	PDF	files	anywhere	you	want	in	the	PDF	file,	then	move	the	added	PDF	files	to	the	start,	end,	or
between	the	existing	file	pages.	Step	3:	Additionally,	you	can	choose	to	drag	one	or	more	thumbnails	to	the	ideal	location.	Method	2:	How	to	Merge	2	PDF	Files	Without	Acrobat	Using	Finder	Finder	is	a	MacOS	file	manager	that	can	help	you	combine	PDF	files	on	your	Mac	without	needing	Adobe.	Here	is	how	to	merge	PDF	files	on	Mac	without
Acrobat:	Step	1:	Switch	to	Gallery	view	from	the	Finder	toolbar.	Step	2:	Hold	down	the	command	key	and	select	the	files	you	want	to	combine.	Step	3:	Select	each	PDF	file	in	the	order	you	want	them	to	be	in	the	merged	PDF	file.	When	selecting	several	PDFs,	you	will	notice	a	pop-up	Create	PDF	button	in	the	inspector	panel.	Step	4:	Hit	the	Create
PDF	button	to	merge	and	create	a	new	PDF	document	on	your	Mac	storage	with	all	PDF	files	merged.	Alternatively,	you	can	select	multiple	PDFs	in	the	Finder's	List	View.	Then,	two-finger-tap	or	Ctrl-click	to	open	a	context	menu.	Select	Quick	Actions,	then	click	Create	PDF	to	merge	PDFs.	Part	3:	How	to	Combine	PDF	Files	Without	Acrobat	[Online
Applications]	There	are	several	online	websites	and	apps	you	can	leverage	to	combine	PDF	without	Acrobat.	This	section	highlights	the	main	methods	to	help	you	combine	PDF	files	without	Adobe.	Tool	1:	How	to	Combine	PDF	Without	Adobe	Using	iLovePDF	iLovePDF	is	a	popular	online	app	for	combining	PDF	files	without	Adobe	Acrobat.	The	merger
can	also	help	you	split	and	convert	PDF	files	without	using	Adobe.	iLovePDF	is	an	efficient	online	app	to	combine	multiple	PDF	files	without	Acrobat	and	without	losing	file	quality.	Here	is	how	to	merge	2	PDF	files	without	Acrobat:	Step	1:	Go	to	iLovePDF	online	page	and	choose	the	Merge	PDF	tool.	Click	Select	PDF	Files	to	upload	the	files	you	want
to	merge.	Step	2:	Drag	and	drop	the	files	to	rearrange	them	in	a	preferred	order.	Click	Merge	PDF	to	merge	the	files.	Step	3:	Click	Download	merged	PDF	to	save	the	combined	file	to	your	local	storage.	Tool	2:	How	to	Combine	PDF	Files	Without	Acrobat	with	Smallpdf	Smallpdf	is	another	alternative	app	to	help	you	combine	PDF	files	without	Adobe
Acrobat.	Like	Adobe,	Smallpdf	strives	to	ensure	safe	and	confidential	file	processing.	It	permanently	deletes	all	uploaded	files	from	its	server	within	an	hour	after	uploading	and	merging.	Smallpdf	boasts	a	simple	user	interface,	and	it's	easy	to	use.	Here	is	how	to	merge	files	into	one	PDF	Without	Acrobat:	Step	1:	Go	to	Smallpdf	online	page	and	choose
the	Merge	PDF	tool.	Drag	and	drop	your	files	or	click	Choose	Files	to	upload	them	for	merging.	Step	2:	Click	MERGE	PDF!	to	merge	the	files.	Step	3:	Click	Download	to	save	the	merged	document.	Tool	3:	How	to	Combine	PDF	Without	Adobe	Using	Soda	PDF	Soda	PDF	can	help	you	combine	multiple	PDF	files	into	a	single	document	without	using
Adobe	or	hurting	file	quality.	It	is	a	web-based	platform	meaning	it's	available	on	any	web	browser	and	can	work	on	any	operating	system.	However,	while	Soda	PDF	can	combine	PDF	files	without	Acrobat,	its	free	trial	account	limits	the	size	of	uploads	and	daily	usage.	It	has	a	simple	user	interface	and	is	effortlessly	easy	to	navigate	and	use.	Here	is
how	to	merge	PDF	files	without	Acrobat	using	Soda	PDF:	Step	1:	Open	Soda	PDF	online	page	and	choose	the	Merge	PDF	tool.	Click	Choose	Files	or	drag	and	drop	your	PDFs	to	merge.	Step	2:	Click	MERGE	FILES	to	merge	the	files.	Step	3:	Click	Download	File	to	save	the	merged	PDF	file.	Tool	4:	How	to	Merge	PDF	Files	Without	Acrobat	Using
PDF2go	PDF2go	is	another	popular	online	app	and	alternative	to	combine	multiple	PDF	files	without	using	Acrobat.	Since	it's	also	web-based,	you	don't	have	to	fear	the	risk	of	downloading	possible	viruses	or	software	when	downloading	desktop	merger	apps.	Here	is	how	to	combine	PDF	files	without	using	Acrobat	and	losing	quality	on	PDF2go:	Step
1:	Go	to	PDF2go	online	page	and	choose	the	Merge	PDF	tool.	Step	2:	Drag	and	drop	your	documents	onto	the	merger.	Alternatively,	click	Choose	Files	to	add	the	files	you	want	to	combine.	Rearrange	your	files	in	the	preferred	order.	Step	3:	Click	Save	As	to	customize	the	destination	folder	and	combine	settings.	Click	the	Save	button	to	merge	the
files.	Click	Download	to	save	the	merged	file	to	your	local	storage.	Tool	5:	How	to	Merge	PDF	Files	Without	Acrobat	Using	PDF24	PDF24	is	an	alternative	online	app	to	combine	PDF	files	without	using	Adobe.	Besides	merging	PDF	files,	PDF24	can	help	you	split,	compress,	sign,	convert,	secure,	rotate,	and	create	PDF	files.	It	is	easy	to	use	and
combines	files	while	preserving	file	quality.	PDF24	is	web-based	and	can	work	on	any	web	browser	and	operating	system.	However,	it	is	also	available	as	a	desktop	app	allowing	you	to	combine	multiple	PDF	files	without	Acrobat.	Here	is	how	to	combine	PDF	files	online	without	Adobe	Acrobat	with	PDF24:	Step	1:	Go	to	PDF24	online	via	your	browser
and	choose	the	Merge	PDF	tool.	Step	2:	Hit	the	Choose	files	button	to	upload	the	files	you	want	to	combine.	Step	3:	Drag	and	drop	to	rearrange	the	PDF	files	in	your	desired	order.	Click	Merge	to	combine	the	PDFs.	Click	Download	to	save	the	merged	PDF	document.	Tool	6:	How	to	Merge	PDF	Files	Without	Acrobat	Using	Combine	PDF	Combine	PDF
is	another	popular	online	website	to	combine	multiple	PDF	files	without	needing	Adobe	Acrobat.	This	app	can	combine	up	to	20	PDF	files	into	a	single	file	without	using	Acrobat	and	without	hurting	file	quality.	Since	Combine	PDF	is	web	and	cloud-based,	you	don't	have	to	download	or	install	any	third-party	software.	Here	is	how	to	combine	PDF
without	Adobe:	Step	1:	Navigate	to	the	Combine	PDF	online	merger	page.	Step	2:	Click	the	UPLOAD	FILES	icon	to	add	the	PDFs	for	merging.	Drag	and	drop	the	files	to	rearrange	them,	then	click	COMBINE	to	merge	them.	The	merged	PDF	file	will	start	downloading	automatically	once	the	files	have	been	merged.	The	Bottom	Line	Though	praised	for
its	convenience	and	reliability,	Adobe	Acrobat	isn't	the	only	way	to	combine	PDF	files.	Freeware	such	as	Coolmuster	PDF	Merger	can	combine	multiple	large	PDF	files	without	Acrobat.	Coolmuster	PDF	Merger	is	a	more	professional,	comprehensive	solution	for	merging	PDF	files	fast,	efficiently,	and	without	losing	quality.	Download	Coolmuster	PDF
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convert	multiple	images	to	one	document,	you	can	use	the	PDF	converter	offered	on	the	website.	Method	2:	Combine	PDFs	on	WindowsFor	those	users	who	prefer	a	desktop	program	instead	of	combining	PDF	files	online,	there	is	a	specialized	PDF	merger	for	Windows	PCs	and	laptops.	PDF	Candy	Desktop	has	a	variety	of	instruments	to	work	with	this
file	format,	including	the	one	to	join	PDFs.See	the	instruction	below	on	how	to	merge	PDF	files	with	this	program:Download	the	PDF	combiner	to	your	computer.	Install	the	program.	Open	the	application	and	locate	the	"Merge	PDF"	tool.	Transfer	the	files	into	the	working	window.Rearrange	the	documents	in	the	order	you	need	them	to	appear.	Set
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documents	without	Adobe	into	one	file	on	Windows	10,	8.1,	8,	7,	and	Vista.Method	3:	Join	PDF	documents	on	macOSIf	you	are	an	Apple	customer,	you	may	as	well	wonder	how	to	merge	PDF	files	into	one	without	Acrobat	on	your	device.	Luckily,	all	macOS	computers	come	with	a	built-in	program	Preview	that	you	can	use	to	combine	PDFs.	Here	are
the	steps	to	take	to	use	this	program	as	a	PDF	merger:Open	the	Finder	window	and	locate	the	PDF	files	you	wish	to	join	together.	Right-click	on	one	of	them	and	select	"Open	With"	and	pick	"Preview"	from	the	drop-down	menu.	Locate	the	"View"	option	on	the	top	toolbar	of	the	program	and	hit	"Thumbnails"	if	they	are	not	already	displayed.	Now
drag	and	drop	the	thumbnails	of	one	document	to	another	to	combine	PDF	pages.Click	the	"File"	menu	and	save	the	resulting	document.The	program	also	has	a	few	additional	features	you	can	take	advantage	of.	For	instance,	you	can	highlight	PDF	text,	add	new	textual	content,	draw,	and	sign.	Utilizing	Preview	is	a	simple	technique	to	merge	one
PDF's	pages	to	the	other	document.	However,	it	does	require	you	to	manually	drag	each	page	you	need	to	appear	in	the	joined	document.	Combining	PDFs	online	vs	offlineAlthough	desktop	applications	are	good	many-in-one	toolkits	to	work	with	PDFs,	there	are	several	advantages	to	combining	PDF	files	online.	Advantages	of	merging	PDF	onlineWith
this	online	PDF	combiner,	you	can	upload	PDFs	not	only	from	the	device	but	also	from	Google	Drive	and	Dropbox.	This	will	greatly	facilitate	your	work,	and	let	you	complete	the	task	on	the	go.	Other	benefits	of	the	service	are:Only	an	Internet	connection	is	required	for	combining	your	PDF	files.Convenient	and	intuitive	interface	of	PDF	merger.	The
format	and	content	of	the	uploaded	documents	remain	unchanged.	Additional	tools	including	a	powerful	PDF	editor.Combine	PDF	files	for	free	online.	No	cost	is	required.Another	interesting	feature	of	the	PDF	combiner	is	that	you	can	preview	uploaded	files.	This	is	useful	if,	for	example,	all	PDF	files	have	complex	or	similar	names.Not	only	you	can
combine	your	PDF	files	without	Acrobat,	but	you	also	have	more	options	for	working	with	this	format.	These	include	compressing	PDFs,	deleting	extra	pages,	and	splitting	and	resizing	your	files.	And	many	more	other	tools	that	are	available	on	one	website.	Tips	for	efficient	PDF	mergingBulk	processing.	If	you	have	multiple	PDFs	to	merge,	use	batch
features	available	in	many	tools.	This	allows	you	to	process	several	files	in	one	operation,	saving	time.Organize	files	properly.	Keep	the	files	you	want	to	join	in	a	single	folder	or	location.	This	makes	it	easier	to	select	them	all	at	once	and	prevents	errors	from	selecting	the	wrong	documents.Number	pages.	Ensure	consistent	numbering	across	all	files.
Our	online	PDF	merger	allows	you	to	automatically	adjust	page	numbers	during	the	process.	Use	bookmarking.	If	your	final	PDF	is	intended	for	navigation	or	reference,	consider	adding	bookmarking	or	creating	a	table	of	contents.Consider	security.	When	processing	sensitive	documents,	use	encryption	and	password	protection	options	to	secure	the
final	PDF.FAQ	on	how	to	combine	PDF	files	without	AcrobatQ1.	Can	I	combine	scanned	PDFs?A1.	Yes,	it	is	possible	to	join	PDFs	that	contain	only	scanned	images	and	not	textual	content.	With	the	online	PDF	merger,	you	can	do	so.	Q2.	Can	I	add	a	new	header	or	footer	after	I	combine	my	PDFs?A2.	Yes,	if	you	need	to	add	header	or	footer	to	the	PDF
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you	find	out	that	there	are	certain	pages	you	do	not	need	in	the	new	file,	you	can	easily	delete	PDF	pages	that	are	irrelevant.	Q5.	Can	I	split	PDF	without	Acrobat?A5.	Yes,	similarly	to	the	online	PDF	combiner,	you	can	utilize	an	online	PDF	splitter	to	divide	your	files	into	pieces	that	need	to	be	shared	separately.ConclusionIn	this	article,	we	showed	you
how	to	merge	PDF	without	Adobe	online,	with	a	Windows	app,	and	a	macOS	program.	All	these	PDF	combiners	are	free	and	easy	to	use.	By	following	the	steps	outlined	for	each	platform,	users	can	seamlessly	combine	PDF	documents	while	maintaining	the	document	integrity	and	optimizing	workflow	efficiency.Explore	your	options	and	make	your
work	with	PDF-formatted	docs	easy	and	fun!
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